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1  Important Basic Information 

1.1 Use of this manual 

The present manual fully describes all options to operate the flashtransfer vario HD (hereaf-
ter called „vario HD“).  Please also note the „Responsibilities of the Operator“ on page  [p.8] 
as well as the “Legal Notes“ on page 9. 

To mark important passages of the text, the following symbols are used: 

 

 

Warning or prohibition! 

Non-observance of this instruction leads to severe defects on the appliance, 
or damages to health or to the product! 
If applicable, the manufacturer’s warranty ceases! 

 

 

Please note! 

This instruction provides you with important information to avoid malfunc-
tions or undesirable results of the final product.  

 

 

Additional Information 

Here you obtain instructions to work more efficiently as well as further in-
formation for a more comprehensive understanding of the functionality of 
the appliance. 

 

Information concerning menu items in the operating software is given in the form 

"main menu -> sub item [-> further sub item]" 

 

The following special terms and abbreviations are used in the user manual: 

HD High Definition: image format with a resolution of 
1.920x1.080 Pixel („1080i“) respectively 1.280x720 Pixel („720p“) 

(HD)SDI Serial Digital Interface: for the transfer of video data (HD/SD) 

LUT Look Up Table: Table of values to translate between analogous and digital com-
ponents, especially for the transfer of colour values to film 

PTR Particle Transfer Roller: Film cleaning roller  

RGB Red Green Blue: Colour space created from the components for red, green and 
blue. 

USB Universal Serial Bus: standardised serial interface to external appliances. 

YUV Colour Space, created from the components luminance (Y) and chrominance 
(U+V). 
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1.2 Scope of Supply 

The varioHD system is delivered in two related functional units: 

1. varioHD-basic appliance  

2. User software to operate the appliance (hereafter called "operating software") 

Additionally, this manual is provided. 

Modules or appliances which may have been delivered additionally by the customer’s re-
quest are not dealt with in this manual and are subject to separate responsibility.  

Appliances required for further processing of the video signals generated by the varioHD, 
such as computer, video recorder etc., are not included in the scope of supply. 

1.3 Responsibilities 

1.3.1 Responsibilities of the Manufacturer / Conformity 

The manufacturer 

MWA Nova GmbH 
Zillestr. 7-11 
D-10585 Berlin hereinafter called “MWA“ 

hereby declares 

that the product „varioHD“ 

meets the legal requirements of the Machinery Directive 98/37/EG – including changes to 
this, valid at the time of the declaration. 

The technical documentation “user manual” has been provided. It documents the conformity 
of the product identified above with the non-applied parts of the applicable harmonized 
standard. 

Berlin, 17.01.2012 

 

_______________________________ 

Frank Ortwein, General Manager 
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The product flashtransfer vario complies with regulations of 

FCC 47 Part 15 Sec 15.105 Class A 

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful interference, and (2) this device must ac-
cept any interference received, including interference that may cause undesired operation. 

This equipment generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his own 
expense. Note: This equipment has been tested and found to comply with the limits for a 
Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to pro-
vide reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. 

Warning! 

This appliance is a class A device. This device can cause radio interference in the living area. 
In this case, the operator can be demanded to carry out special measures. 

 

1.3.2 Responsibilities of the Operator 

The present user manual has been generated with utmost care and under observance of the 
necessary inspections. Mistakes, however, cannot be ruled out. Therefore, it is the user’s 
responsibility to implement explanations and instructions in accordance with the regulations 
and adapted to real conditions. MWA does not assume liability for damages resulting from 
irresponsible operation which is not in accordance with technical logic! 
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1.4 Legal Notes 

For delivery and bringing the appliance into service as well as guarantees, the General Terms 
and Conditions of MWA are valid (www.mwa-nova.com/contact-terms.htm). 

Only some selected and general principles are described hereinafter. 

In the framework of legal regulations, MWA guarantees an impeccable function of the appli-
ance in its standardized scope of supply (page 77). The use of additional appliances and mod-
ules (explicitly also the ones purchased from MWA) together with the varioHD is on the us-
er’s own responsibility and at his own risk. 

Proper use of the appliance in accordance with the instructions provided in this manual, as 
well as the operation by special staff trained by MWA is the precondition for a guarantee. 

MWA grants a warranty free of charge within the legal period of 6 months as from purchase 
date if malfunctions are due to construction defects or material fatigue. After the warranty 
period, MWA grants a warranty extension. Precondition for the latter is the use in accordance 
with the instructions in this manual. Malfunctions occurring after an emergency shut-down of 
the appliances are not subject to the warranty. 

Equally, MWA does not grant a warranty for defects resulting from a use of a software or 
hardware which goes beyond the one in this manual, even if this has been delivered or acti-
vated by MWA at the customer’s request. 

All warranties, however, only cover the replacement or repair of the appliance or respectively 
its modules, as well as expenditure involved, especially transport costs. MWA does not grant 
compensation for the user’s loss of sales, materials (especially used film material) or possible 
claims of third parties, e.g. because of resulting delays in production. 

Place of jurisdiction and place of performance is Berlin (Germany). 
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1.5 Service Address 

For assistance and service requests do not hesitate to contact us 

 

Monday to Friday: 9:00 am – 6:00 pm 

Service phone: +49-30-3980 190-0 

E-mail: support@mwa-nova.com 

 

You can contact us out of office hours 

 

by FAX: +49-30-3980 190-99 

by e-mail: info@mwa-nova.com 

by post: MWA Nova GmbH 
Zillestraße 7-11 
D-10585 Berlin 
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2 Safety 

Compliance with the following safety instructions and regulations does not only grant the 
promised functionality of the appliance as well as protection of the operator’s health and 
safety, but is also a necessary condition for a warranty free of charge on the part of MWA in 
case of malfunction. 

The common safety standards which are applied for other office and cinematographic IT-
devices are also valid for the varioHD. No additional special precautions are required to start, 
operate and shut down the appliance.  

2.1 Emergency Procedure 

In case of unforeseen behaviour of the varioHD or external situations of emergency, the ap-
pliance can be stopped immediately by pressing the two load-stop keys (compare Figure 1:  
[p.15]). 

In extreme cases of emergency, it is also possible to switch off the appliance by pressing the 
power switch, pulling the mains plug at the varioHD or interrupting the power supply by oth-
er means. 

In each of the cases mentioned above, however, all unsaved data is lost! If a scan job is still 
running at this moment, it must be repeated completely later on, as all information re-
quired for a re-recording is not available anymore. Moreover, unpredictable defects may 
occur at single modules due to an uncoordinated switching off. 
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2.2 Use of the Machine According to Regulations  

2.2.1 Application Field 

The varioHD is used for the transmission of 16 mm and 35 mm motion pictures (if applicable 
including sound) into digital video signals. 

The appliance may only be used for commercial purposes and operated by trained staff. 

The further processing of the video signals, especially the conversion into video files, must be 
carried out on a suitable computer. The hardware and software required for this, as well as 
their functions are not dealt with in this manual. 

2.2.2 Demands on the Staff 

The varioHD should only be operated by staff trained by MWA. Alternatively, training can be 
carried out by third parties, if these have been authorized by MWA. Moreover, basic 
knowledge in dealing with film material, devices of film technology, computers as well as 
experience in digital image processing are required.  

2.2.3 Environment Conditions 

In order to grant a safe functionality of the appliance, the following physical conditions must 
be obeyed: 

Power supply 100V...240Hz ≈ resp. 50V...60Hz   (Note type 
plate!) 

Power input max. 660W, average 150W 

Safety class Safety class I according to VDE 0804 (standard of the 
German Association for Electrical, Electronic and Infor-
mation Technologies) 
Insert mains plug only into shockproof sockets!  
Any interruption of the protective contact inadmissible! 

Relative air humidity 40%...60% 

Room temperature 15°C…25°C (60°F…95°F) 
air-conditioned room recommended 

Room size min. 3.0m x 2.0m x 2.5m (L x W x H) 

Wall distance min. 0.2 m to all sides 

2.2.4 Safety Instructions 

2.2.4.1 Positioning Conditions  

The varioHD has been designed for rooms equipped for the operation of appliances of data 
processing and film technology which, above all, are dry and dust-free. Make sure, in particu-
lar, that the varioHD is positioned on plane, solid and unyielding ground. This should be free 
of electrostatic influences. The appliance must not be placed in the immediate proximity of 
high frequency fields or high voltage plants. Moreover, sufficient air circulation must be pos-
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sible, the room should not be smaller than 3,0m x 2,0m x 2,5m (L x W x H) and a minimum 
distance of 0,2m to all sides should be granted. Furthermore, the guidelines for rooms, where 
films are stored and processed, should be obeyed. In particular, the relative air humidity 
must be between 40% and 60%. Too great dryness leads to a desiccation and shrinking of the 
film, to high moisture to maceration. Air-condition and forced ventilation are not absolutely 
necessary, but recommended. 

2.2.4.2 Positioning, Bringing into Service  

Bringing the system into service should be carried out exclusively by service staff of MWA 
or authorised staff! 

The same is valid for possible uninstalling, transport etc. These tasks are part of the total per-
formance of MWA in connection with the purchase or repurchase of the appliances. The us-
er’s own activities within these phases lead to the loss of remaining warranty claims! 

2.2.4.3 Preventive Measures during Operation  

- Always keep the cover of the camera (see Figure 1 [p.15]) shut during all opera-
tions, to avoid damage of the optics. 

- Never reach into the area of the film track or the moving film reel! This could cause 
considerable injuries, in particular cuts and contusions! 

- During operation, avoid contact of hair or clothes with all moving parts. Entrain-
ment at moving components can cause severe injuries. 

- Due to design, the appliance contains open case parts. Never touch the inner elec-
tric and mechanic components, which may thus be accessible, when the appliance 
is switched on. Besides a possible damage of the appliance, above all, there is the 
danger of electric shocks and external injuries. 

- Do not open the appliance! This may only be done by specialised staff authorised 
by MWA. There is the danger of an electric shock! 

- Do not change mechanic or electric settings on the appliance, unless they are ex-
plicitly described in the present user manual. This is especially valid for the adjust-
ment of the optics - in particular do not change the set focal ratio, exposure time 
etc. Otherwise, errors in the play back may occur. 

 

Attention! 

The appliance operates with a class 1 laser. 
 Laser beams can cause severe and irreversible damage when hitting the unprotected 
eye! 
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3 Technical Data 

Weight 45 kg 

Measurements (Width x depth x 
height) 

without film reels: 1,280mm x 448mm x 1,305mm 
incl. film reels: max.  

Mains connection 100…240V (50Hz…60Hz) 

Power input max. 660W, average 150W 

Film length up to 1.200 m (4.000 ft) 

Film material (input) 35mm with/without sound track 
16mm with/without sound track 

Output signal (HD)SDI, Audio embedded or AES/EBU 

Aspect ratio (Output) SD 4:3 576i (720 x 576 pixel, 50 fields) 
SD 16:9  576i (720 x 576 pixel, 50 fields, anamorphic) 
HD 720p50 (1.280 x 720 pixel, 50 frames) 
HD 1080i50 (1.920 x 1.080 pixel, 50 fields) 
HD 1080p25 (1.920 x 1.080 Pixel, 25 frames) 

Depth of colour 3 x 10bit YUV 

Scanning speed (fps) Preview: 50…300 (35mm), 50…800 (16mm) 
Scanning: 4,166…25 

Film drive Capstan (electric motor with disc-shaped rotor) without sprocket rollers 
PTR film cleaning rollers (optional) 

Lighting RGB LED, colour values adjustable 

Camera 3-Chip 
Zoom and focus motor-controlled 

Connections 2 x HD-SDI (audio embedded) with image pre-processing 
1 x HD-SDI (audio embedded) unformatted 
Sync: B-/Tri-Level Input, biphase GPIO 
Audio AES/EBU 
USB 

Operation Film insertion manually 
Film format setting (16mm/35mm) manually 
device control by user software (GUI) 

 

For external hardware (not within the scope of supply) the following recommendations are 
valid: 

- Reference monitor 

· Brodcast-Class-1 monitor or equivalent, HD native 

- Editing computer 

· Graphics card with a dissolution of min. 1,920 x 1,080 Pixel (HD native) 

· Video Raid (Raid-Level 0, minimum 4 hard discs) 

· Capture card SDI 

- Control Computer 

· Graphics card with a dissolution of min. 1,024 x 768 Pixel 

· USB 2.0 

- Operating system 

· Windows XP/Vista, Mac or Linux. 
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4 Installation and Function 

 

Figure 1: Front View 
 

1. Source reel 

2. Load-Stop switch for source reel 

3. PTR film cleaning rollers (optional) 

4. Perforation sensor (Laser) 

5. Signal lamp (see „Event Messaging“ [p.54]) 

6. Camera cover with locking screw 

7. Optics 

8. Filmgate with fan 

9. Light source (lamp housing) 

10. Capstan (film drive) 

11. Load-stop switch for target reel 

12. Magnetic head 16mm 

13. Magnetic head 35mm 

14. PTR film cleaning rollers (optional) 

15. Target reel 
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Figure 2: Back View 

 

1. Power switch 

2. Mains plug 

3. (HD)SDI-output 1 

4. (HD)SDI output 2 

5. (HD)SDI output 3 

6. (HD)SDI output 4 

7. Genlock IN 

8. USB 2.0 

9. Audio Analogue OUT Left 

10. Audio Analogue OUT Right 

11. Audio Analogue IN Left 

12. Audio Analogue IN Right 

13. Audio AES/EBU IN/OUT 1 

14. Audio AES/EBU IN/OUT 2 

15. Audio AES/EBU IN/OUT 3 

16. Audio AES/EBU IN/OUT 4 

17. RS 422 

18. GPIO 
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The varioHD is used for the transmission of 16 mm and 35mm motion pictures (if applicable 
including sound) into digital video signals. Any further processing of these signal currents 
must be carried out on external appliances. The following figure Figure 3pictures this inter-
play.  

 

Figure 3: System Integration 

The interfaces have the following functions: 

-  (HD)SDI 1 / (HD)SDI 2: 
Pre-processed video signals of the scanned film images (with embedded sound sig-
nal). The image information indicated has been formatted in correspondence with 
the adjustments determined in the operating software (GUI).  
This is valid for:  

· Format (Aspect Ratio: SD 4:3 / HD 16:9, anamorph) 
· Image size (Masking) 
· Colour (B/W, Colour Correction, Black, Gamma, Light) 
· Image content (Crisp, Detail) 

- (HD)SDI 3/4: 
Pure video signal of the scanned film images (with integrated sound signal) without 
pre-processing (with exception for the negative-positive-switching). 

Attention!  
On these channels the output is always carried out in full video format 1,080i50.  
If image limitations and colour corrections have been set (see „6.2.2 Set Aspect Ra-
tio“ [p.30]) they have no effect here! 

- AES/EBU: 
digital mono-/stereo sound signal 
Sound signals fed into the varioHD are outputted as embedded sound in the SDI sig-
nal 

- Genlock: 
Tri-Level-Sync (studio phase) 

- Biphase GPIO: 
Channel for the synchronization between varioHD and external studio devices, such 
as MWA MB51 for 2striped scanning image and sound 
(GPO and GPI freely programmable) 
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- USB: 
Connection between varioHD and computer (control computer) on which the operat-
ing software is running (GUI). 
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5 Positioning and Connection of the Appliance 

This section treats the necessary tasks after an internal transport, but not the first bringing 
into service which can only be carried out by MWA (see also 2.2.4.2 „Positioning, Bringing 
into Service“ [p.13]. 

5.1 Internal Transport and Positioning 

Generally, two persons should be involved in the transport of the varioHD. 

Before each internal transport, the varioHD must be switched off and all connections be in-
terrupted. Furthermore, film reels still in place should be removed.  

Attention!  
Before each transport the camera must be locked! To do this, set "Zoom" and "Focus" on 
the GUI to zero and "Pan" to  maximum [p. 31]. Thus the camera goes to a safety position 
(maximal distance from the filmgate). Otherwise damages to the optics or the camera itself 
might occur. 

In any case, the transport must be carried out on a plane surface, without any vibration, in 
upright position of the appliance and in a dry environment! 

Over longer distances or uneven ground, the varioHD should exclusively be transported by a 
suitable and damped trolley. 

For the positioning refer to 2.2.4 “Safety Instructions” on page  [p.12]. 

5.2 Installation of the Operating Software (GUI) 

The provided CD contains the software (GUI) belonging to the varioHD. 

The appliance is controlled almost exclusively by the operating software! Only the follow-
ing adjustments are carried out on the appliance: 

- Insertion and removal of the film 

- Switching the perforation position of the laser [S. 23] 

- Switching on and off the Appliance [S. 2020] 

For installation, the CD must be inserted into the corresponding drive of the control comput-
er (Figure 3 [p.17]), and then the following instructions on the monitor must be obeyed. 

After finishing the installation, the operating software is started by double-clicking on the 
desktop symbol. 

You can start scanning films when at least the following connections have been established 
on the varioHD: 

- USB to the control computer 

- (HD)SDI to the editing computer and/or reference monitor 
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5.3 Connecting and Switching on the Appliance  

All required connections of the varioHD can be found at the back of the appliance (see Figure 
2 [p.16]). 

Before bringing into service, at least the following connections must be established (compare 
Figure 3 [p.17]): 

- USB to the control computer 

- (HD)SDI 1...4  to the reference monitors 

- power cord 

Further connections can be made optionally (see Figure 2 [p.16]): 

- Audio Analogue from and to an analogous sound playback or 
  recording device 

- AES/EBU to a sound recording device or loudspeaker  

- GPIO  to a further studio device which shall be synchronized with the vari-
oHD 

- RS422 to the editing control system 

After that, the varioHD can be put into operation over the power switch. 

Then start the operating software. It connects to the appliance which is confirmed by a sound 
signal. 

If the software has been started before switching on the varioHD it must be connected with 
the appliance manually over the menu "File -> Connect". 

5.4 Switching off the Appliance 

The varioHD is switched off over the power switch on the back (compare Figure 2 [p.16]). 

Before switching off the appliance, all jobs should be finished and the machine should be in 
the Stop mode [p. 26]. 

Further precautions are not necessary before switching off. 

Furthermore, it is recommended to remove possibly still inserted film, as otherwise the film 
could be deformed by remaining in the film track for a longer time. 
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6 Operation 

6.1 Setting 

Note: 
Hereafter also elements of the operating software are described. There, the button can be 
found in different positions . By this, you can put all settings of the corresponding section 
to the respective standard (without further query). 

6.1.1 Insert Film  

Inserting the film requires maximal five steps in the following order. 

6.1.1.1 Change Filmgate  

This step is only necessary if a film with a different format has been scanned before. 

During this process, make sure not to touch the optics of the camera above or the glass 
cover of the lamp housing below! 

Run the camera to the safety position! To do this, you must set the values for "Zoom" and 
"Focus" to zero by the control programme [p. 31]. Then the camera goes to a maximal dis-
tance from the filmgate. 

To disassemble the filmgate proceed as follows (see Figure 4 [p.22]): 

1. Loosen the lock of the lamp housing and lower it completely. 

2. Loosen the winged screw to the left of the lamp housing. 

3. Loosen the hexagon socket screw to the right of the lamp housing 

4. Take hold of the gate including the fan casing and lift it upwards out of the anchor-
age. 

5. Pull the power cable for the fan. 

The assembly is carried out in reversed order. 
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Figure 4: Disassembly of the filmgate 

6.1.1.2 Set Film Path 

For 16mm film the plate of both reels must be pulled forwards, respectively pushed back-
wards for 35mm film. 

In case of 35mm film on a reel, it is necessary to remove both plates to equalise the mechani-
cal thickness of the carrier reel. Otherwise the film will not be placed exactly in the film track. 

If the film is reeled on a bobbin, the provided adapter must be attached to the reel before-
hand. Otherwise the appliance will not be able to move the film.  

Insert the film to be scanned generally on the left side of the varioHD and then lace it accord-
ing to the red line in Figure 1 [p.15] into the film track. 

If you intend to use the PTR film cleaning roller additionally, the film must be inserted follow-
ing the yellow path. 

The winding direction on the target reel can be selected freely – it will be communicated to 
the varioHD later. 
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Please make sure that the inserted film is rolled to the beginning. In case of 16mm film, 
moreover, the perforation must be directed to the front. 35mm sound film must be insert-
ed the way that the soundtrack points to the back. 
The resulting winding direction of the film is irrelevant for the moment. Equally a possibly 
mirror-inverted picture on the monitor. This can be corrected later by means of the mirror 
function [p. 35]. 

Attention!  
Before insertion, run the camera to the very top (set zoom to minimum [S. 31] to avoid 
damages of the optics. 

It is not required to establish a particular tension of the looping of the moveable rollers. The 
appliance will regulate this later on its own. 

6.1.1.3 Set the Film Format  

After that set the perforation sensor (No. 4 in figure Figure 1 [p.15]) to the current film type: 

a) for 35mm push the sensor to the very back position. 

b) for 16mm push the sensor to the very front position. 

 

 

35mm 

 

16mm 

Figure 5: Settings of the perforation sensor 

Thus, the laser ray responsible for the recognition of the perforation is mechanically oriented 
according to the measurements of the film formats. 

Check if the laser ray is running over the middle of the perforation holes. 

6.1.1.4 Activate Sound 

Depending on the features of the appliance, 35mm optical sound or 16mm optical and mag-
netic sound can be transmitted. To do this, activate the corresponding magnetic head on the 
right side of the lamp housing, after inserting the film, by extracting it all the way toward the 
front (see Figure 6 [p.24]). 

The perpendicular position of the magnetic head to the direction of the film path can be ad-
justed by the adjusting screw S. The film must be placed exactly in the middle between the 
guiding rollers. 
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Figure 6: Activation magnetic head Figure 7: Guiding rollers at the magnetic head 

 

 

For technical reasons, it is necessary that the guiding rollers of the magnetic head rest on 
the film. Thus, mechanical stress of the film material cannot be avoided in case of frequent 
film movement. 

Therefore, avoid any unnecessary film movement when the magnetic head is activated, 
especially fast winding. 

As possible, do not activate the magnetic head until right before the scan starts! Further-
more, make sure that the guiding rollers are clean and dust-free! 

 

6.1.1.5 Establish Run Mode 

After inserting the film and, if applicable, activation of the magnetic head, two settings have 
to be made in the operating software: 

1. Input of the current winding directions 

To do this, click on the respective figure of the source and target reel until the graph 
shown corresponds to the actual film path on the appliance. 

Alternatively, you can press and hold the load-stop switch corresponding to each reel for 
longer than 1 second (see Figure 1 [p.15]). Thus the winding direction is also changed in-
ternally. The appliance will indicate the new winding direction by a slow turn of the reel. 

 

Figure 8: Example film path 

2. Input of the present winding directions 
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To do this, click on the illustration of the source reel, respectively the target reel, until the 
shown graphic corresponds to the actual film path on the appliance. 

 

Figure 9: Selection of film format  

Note: 

Certain pre-settings can be linked to the selection of the film format, which are then set 
automatically. Further information can be found under 6.3.2 αStore and Load Settingsά 
[p.47]. 

Now, the setting of the varioHD and the operating software is finished.  

To be able to scan the film, change into the run mode by clicking on   or press and 
hold both load-stop switches together for a short moment.  

Now the varioHD will tighten the film and check if all parts of the film path are adjusted im-
peccably. Then the operating software will change to the "run" section. 

Should the film not be tightened or come to a stop after a short period, stop the process by 
pressing one of the two Load-Stop switches on the appliance and check the following points: 

- Is the actual winding direction congruent with the settings you have made in the op-
erating software? (see Figure 8 [p.24]) 

- Has the film been inserted properly? 
This, beside the correct film path is especially valid for the areas of the perforation 
sensor, the scanning unit and, if applicable, the magnetic head. There the film should 
run through impeccably, fit smoothly, and run straight and flatly everywhere. 

- Is the position of the perforation sensor congruent with the selection of the film type 
in the operating software? (see figure Figure 9) 

All steps to follow now can be seen in section  „“All steps to follow now can be seen in sec-
tion 6.2 „Scanning“ [p.29] 

By clicking on  or pressing one of the Load-Stop switches, you can return from the run 
mode to the load mode (inserting the film) at any time. 
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Ein/Aus

Load

Run

Play

Shuttle

Step

Alle Motoren aus

Film einlegen

"Run" anklicken

oder am Gerät

beide Load-Stop-Schalter drücken

Film gespannt und abspielbereit

Film läuft

"Load" anklicken

oder am Gerät

einen Load-Stop-Schalter drücken

Alle Motoren aus

Film auslegen

"Stop" anklicken

Film hält an

Film noch gespannt

 

Figure 10: Operating order 

Note: 
The transition from "run" to "load" and vice versa does not influence the frame counter, as 
long as the film is resting tightly and in unchanging position on the capstan roller (right side of 
the filmgate). Only an interruption by pressing one of the load-stop switches or by the appli-
ance itself in case of an urgent transport problem will cut the internal counter from the actual 
film path. In this case the starting position (Bild "0") must be re-determined. 

6.1.1.6 Further Settings  

a) Tension 

When using particularly sensitive film material, it might be necessary to reduce the 
tension by which the film is being transported to avoid that the film is torn or other-
wise damaged. 

By the option "tension" this value can be controlled (Figure 11). 

 

Figure 11: Tension 

For any of the two operating states "Run" (Scanning) and "Wind", there is a possibility 
to determine a particular value.  

b) Perforation detection 

The varioHD determines the image position with the help of the position of the per-
foration holes by means of a laser sensor. In case of extremely clear films, it might be 
necessary to increase the detection sensitivity, as the difference in translucence be-
tween film material and perforation hole is very small. For this case shift the control 
towards "Sensitive". 
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By this setting the sensor will become so sensitive that even variations of the sur-
rounding light might influence and disturb the detection of perforation holes. Dark-
en the room, as possible. 

In case of films with a high share of blackening, the control can be shifted towards 
"Accurate". Thus, the influence of the surrounding light is also reduced. 

For most films, an average value is sufficient. 

 

Figure 12: Perforation Detection 

c) Filmgate fan 

By this the ventilation of the light source can be switched on or off during the scan-
ning. This is an additional function to remove superficial dust on the glass of the light-
ing unit or in the room.  

6.1.2 Remove Film  

Before removing the film, the magnetic head should be deactivated, i.e. shifted backwards 
into the parking position. The guiding rollers at the magnetic head are resting very tightly on 
the film and might cause damages of the film material if handled without care.  

In order to remove the film, press one of the Load-Stop switches or click on  in the 
operating software. Then the film is loosening again and can then be taken from the film 
track completely. 

The transition from Run to Load (Load-Stop switch or over the flashsuite) has no influence to 
the internal frame counter for the moment. This, however is linked to the capstan (No. 10 in 
Figure 1 [p.15]). A shift of the film during the stop on this roller causes an inaccurate counting 
of the motion pictures. 

6.1.3 Winding the Film  

In the loaded state, the film can be fast forward or run back at a rate of up to 100 images per 
second any time (compare „“)Film Transport. [p.29] 

However, in order to quickly wind a complete film, e.g. after finishing the scanning, it is rec-
ommended to use the „Wind“ function intended for this. (see Figure 14 [p.28]). This grants a 
significantly lower mechanic stress of the film material. 

Should the varioHD still be in the run mode (film tightened), loosen the film tension by push-
ing the Load-Stop switch [S. 15]. 

After that, insert the film as follows: 
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Figure 13: Film Path for Rewinding 

The direction in which the film lies on both film reels does not matter for the moment. 

After that communicate the actual winding direction to the operating software by clicking on 
the depicted film reels. To do this, click on the respective figure of the source and target reel 
until the graph shown corresponds to the actual film path on the appliance. 

After that,  activate the rewinding function by a click on the button  .  

By the switches below, the direction and speed of the rewinding can be determined or the 
process can be stopped. 

 

Figure 14: Wind Control 

Doing this, a click on the buttons  resp.  causes a rewinding at the highest 
possible speed. For more sensitive film material, however, the slide control should be used to 
adjust a lower winding speed. 
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6.2 Scanning 

After inserting the film and transition to the run state, the surface (GUI) of the flashsuite for 
the actual scanning appears: 

 

Figure 15: Start Screen Run Mode 

After inserting the film and changing into the run mode, the surface for the actual scanning 
appears on the screen: 

Top third: „colour Correction“ Settings for colour correction 

Left centre: „Geometry“ Zoom, focus and image position 

Bottom left: „Advanced settings“ Sound, image processing, geometry  

Centre: „Transport“ Film movement, speed 

Bottom right: „Cue points“ List for settings by scene 

All steps required for the preparation are described in detail on the following pages. After 
completing these jobs, you will start the actual scanning. To do this, proceed as follows: 

1. Start the video recorder connected to the varioHD, or respectively your video-
recording software. 

2. After that start the playback on the varioHD by the switch  or the space bar. 

3. After completing the scanning, first stop the recording on the video recorder, then 
stop the film by clicking on . 

 

6.2.1 Film Transport and Positioning 
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Select a suitable film speed over the speed list. The information is given in images per se-
conds (fps). 

 

Figure 16: Film Speed 

This can be done by opening the list, over the switches [+] and [-] to its left and right, or by 
the + and - key on the numeric pad of the computer keyboard. Various levels between 4,1666 
and 800 fps are available for speed (for 35mm film a maximum of 300 fps). 

 

Attention! If a speed is marked by an asterisk (*), it can only be used for purposes of pre-
view, but not for the actual scanning! 

 

By the switches   you can move the film forwards and backwards in the 

selected speed, or transport it in steps of single images. The switch  
stops the movement. 

Note: 
Changing between play and stop mode is also possible by pressing the space bar. 

A more rapid transport of the film is possible over the shuttle control beneath the speed se-
lection. 

After that, move the film to the first image or a suitable start mark and click on the button 
“0” next to the image counter. Then the latter is set to zero.  

You can specifically go to this or any other image position by entering the number of the de-
sired image into the field beneath the image counter and click on the button “Cue”. 

 

Figure 17: Go to Image Position 

The determination of a defined beginning of the film is not only important for a comfortable 
positioning of the film during work (including rewinding to the beginning), but also vital condi-
tion for corrections scene by scene (see section 6.2.6.1 [p.43]) possible measurements (see 
αFehler! Verweisquelle konnte nicht gefunden werden.ά [p.Fehler! Textmarke nicht 
definiert.])! 

6.2.2 Set Aspect Ratio 
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The setting of the image section to be scanned is carried out in two steps:  
vertical limitation by zoom and frame line as well as horizontal limitation by aspect ratio, 
image position and lamination. These are explained below. 

The setting of the image section is carried out in two steps: vertical limitation by zoom and 
frame line as well as horizontal limitation by aspect ratio and lamination. 
These are explained below.  Therefore, after determination of the image section, let the film 
run for a short moment, to make sure that all images are presented in the desired way. 

For the next step, now look for an image, of which the external frames are easily recogniza-
ble, in order to determine the image section. 

6.2.2.1 Top and Bottom Image Limitation, Zoom and Focus 

Top and bottom limitation of the image section are determined by the zoom factor and the 
positioning of the frame line. 

Use the setting options in the area “Geometry” for this: 

 

Figure 18: Setting the Image Geometry 

In the first step, the zoom (magnification of the image and thus the visible section) should be 
set. Shift the corresponding control to the right or left until the desired image section is 
roughly set for the moment - the fine adjustment follows after that. The change in zoom al-
ters the position of the camera to the film surface and makes a correction of the present 
sharpness necessary. This is done with the "focus" control below. Change its position until 
the picture on the reference monitor is sharp for the first time. 

Should the image be shifted vertically (film path), correct it  upwards or downwards by the 
“Frameline” control. A click on the buttons "+" or "-" causes a skip of the image upwards or 
downwards by one space of the perforation holes. 

If the image is shifted horizontally, you can correct the image position over the "Pan" control. 

This process can be repeated until the desired top and bottom limit as well as the horizontal 
position for the image section have been found. 

After that, the focus should be adjusted once more. For this purpose, you can use the focus 
indicator. The longer the displayed bar, the sharper is the image. If the bar ranges near the 
maximum, reset it to a medium value by clicking on the key “Fit” so that it can gain further 
scope. The sharpness set up to then is not being influenced by this! 

If the image content does not provide enough clues for the adjustment of the focus, use the 
switch “EZ Focus” (pronounced “Easy Focus”). If this is activated, all details present in the 
image (grain, edges etc.) will be temporarily increased to an extreme extent at the moment 
when the "focus" control is operated by the mouse. Thus, the point of maximum sharpness 
can usually be found very easily. The sharpness enhancement is only effective for as long as 
you are operating the focus control. 
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Note: 
All shift controls can also be operated over the keyboard. This often enables a much more 
precise adjustment of the corresponding values. For this purpose, the controller concerned 
must first be selected (activated) by a mouse click. After that, shifting the controller in very 
fine single steps over the arrow keys is possible. 

Additionally, a change between single elements of the screen is also possible by the tabulator 
key (TAB resp. Shift-TAB). 

Additional Function „Focus LUT“ 

 The tracking of the sharpness which is always necessary when the focus is changed can be 
automated so that from then on it is sufficient to set a value for the zoom. The related sharp-
ness will then be regulated by the varioHD automatically. 

To do this, a so-called focus LUT must be set up. This is a translation table in which relates a 
corresponding focal point to each zoom position. 

For the set-up of the focus LUT, the menu item "View" -> Focus LUT is at your disposal. In the 
window then opening you can see a surface diagram presenting horizontally the range of 
values of all zoom positions, and vertically the complete focus area (Figure 19). 

 

Figure 19: Focus LUT 

In the initial state the diagram is still empty. Now proceed as follows 
(during all operations the focus LUT window may remain open): 

1. Deactivate the option "Use Focus LUT" to prevent undesired side-effects caused by 
previous settings.  

2. Shift the zoom control to position 0. 

3. Set an optimal sharpness - independently from the visible image section. 

4. After that, click on "Add Focus Point" in the focus LUT window to generate a point in 
the graph. 

5. Then adjust the zoom to a slightly higher value. 
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6. Repeat the step sequence of point 3until all desired zoom positions have been run 
through. 

In the lower area of the zoom values, a very small step range should be chosen, in order to 
generate a graph as dense as possible. In case of higher zoom values, larger step ranges are 
possible, as the slope of the resulting graph is not very high anymore. 

You can go to and control each generated point on the graph by mouse click. 

Points which have been placed by mistake must first be deleted and then re-generated. A 
graphic shift is not possible. For this case, change from "Graphical view" to "LUT Points". 
Mark the corresponding pair of values by the right mouse key and chose "Delete" (Figure 
20Then generate a new point as described above. 

At the end of this process, a graph similar to the one in Figure 19 [p.32] should have been 
created. Over the menu item "LUT -> Save" (in the diagram window) this must be saved. Only 
one single LUT file is filed. Therefore, no file name can be given. Over "LUT -> Open" you can 
re-activate the saved LUT at any time. 

Finally, activate the option "Use Focus LUT", and the automatic tracking of the sharpness 
according to a chosen zoom position is switched on.  

 

Figure 20: Focus LUT correction 
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6.2.2.2 Define Output Format (Output Processing)  

Change to the area „Output Processing“ at the bottom left of the screen. 

Important! 
All output processing settings described hereafter only become effective at the outputs 
(HD)SDI 1 und 2 (see Figure 2 [p.16]). The outputs (HD)SDI 3 and 4 always render the uned-
ited video signal of the scanner camera. 

 

Figure 21: Output Processing 

Initially should be determined in which video format the image output shall take place.  
The following options are available: 

- SD 4:3 Output format 720x576 Pixel (SD) 

- SD 16:9 Output format 720x576 Pixel (SD) 
By anamorphic compression in horizontal direction, significantly more im-
age content can be comprised here. This format is especially suited for a 
16:9 TV playback if the image width shall be fitted (otherwise the format 
4:3 should be chosen for this playback form) 

- 720p50 Output format 1.280x720 Pixel (HD, progressive) 

- 1080i50 Output format 1.920x1.080 Pixel (HD, interlaced) 

- 1080p25 Output format 1.920x1.080 Pixel (HD, progressive) 

Furthermore you can determine (see Figure 21): 

- Black and White 
Output in pure black-and-white format 
This setting makes sense for black-and-white films containing discolouration due to 
the film material or storage processes. 

Tip: Scanning black-and-white material:  
¢ƘŜ α.ƭŀŎƪ ŀƴŘ ²ƘƛǘŜά ǎǿƛǘŎƘ ǊŜƳƻǾŜǎ ŀƭƭ ŎƻƭƻǳǊ ƛƴŦƻǊmation from the image 
signal so that the image is scanned completely without any colour tinge. 
However, it sometimes occurs that black-and-white material and coloured 
material are mixed up on one roller. Scanning in the black-and-white mode, 
you might not realize this change. The SDI outputs 3 and 4 always carry all 
colour information. Looking at the image over one of these outputs, you can 
easily recognize when coloured material is being scanned again. 

- Anamorph 
Expand output horizontally by the factor 2:1 
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Use this option to rectify images which have already been recorded anamorphically 
(i.e. horizontally compressed). 

- Mirror  
Mirroring in horizontal direction. This enables you, among other things, to scan a film 
which has been inserted mirror-inverted, without having to change it again. 

- Negative 
When this option is activated, brightness and colour of the image are inverted on all 
outputs of the varioHD to make the scanning of negative material easier. The colour 
circles of the primary colour corrections [p.36] appear achromatic. This means that 
the actual colour of the light source is inverted exactly against the colour in the col-
our circle. Note that the light settings now take effect on the dark regions of the im-
age, while the black settings take effect on the bright image areas. 

Tips for negative scanning 

· Depending on the film material and its exposure, in case of negative scan-
ning it might be necessary to enhance the video gain in "Advanced Image 
Settings" [p.40] and slightly decrease the white clip value. 

· In order to compensate the orange mask of the carrier material, the auto 
light function is very suitable. [p. 38]. 

· You can set up the adjustments made under "Advanced Image Settings" as 
automatic pre-setting which is always activated when you choose the option 
"negative" in "Output settings". 
Further information can be found under 6.3.2 αStore and Load Settingsά 
[p.47]. 

Special Features in Case of Interlaced Format 

Interlaced video consists of fields which only contain every second line of the full image reso-
lution. Two of these fields ("Fields") constitute one frame ("Frame").  

When working in an interlaced format, one image on the film expands to two frames in the 
resulting video. 

In case of lower scanning speeds film images must be repeated as the video recording rate of 
25fps is pre-determined. Doing this, different possibilities of image repeating result, which 
you can configure in "Options -> Preferences -> Interlacing Settings" [S. 53]. 

Higher transport speeds are only available for the preview. They can be recognized by an 
asterisk (*) behind the speed value. 

6.2.2.3 Set Image Section 

Finally, the physical limitation of the image section in horizontal direction must be deter-
mined. To do this, shift the green limitation line (lamination) in the shown black image field 
until the desired section has been reached (see Figure 21 [p.34]). 

Doing this, note that the resulting image content is always positioned in the centre of the 
outputted video image automatically.  

Here you can make a more precise selection, too, if you first click on one of the limitation 
lines and then position it by the arrow keys of your keyboard. 

6.2.3 Set Colour Values 
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The setting and correction of the colour values is carried out in the area in the top third of the 
screen.  

This area contains two parts available by tabs on the top margin: 

- Primary colour Correction: All settings carried out here, directly influence the behav-
iour of the camera and light source of the varioHD. 

- Secondary colour Correction: Only changes the chroma channels and determines the 
shape of the colour space. Black-and-white images are not changed by this correction 
function. 

6.2.3.1 Primary Colour Correction  

 

Figure 22: Primary Colour Correction 

Here you can find three chromatic circles in the left part, to each of which one slide control 
belongs on its right. By the controls, the correction values Black, Gamma and Light are ad-
justed. 

The marking cross within the chromatic circles is usually positioned in the centre. Thus, the 
standard value takes equal effect on all parts of colour and brightness in the image. If the 
cross marking, however, is shifted towards the edge of the circle to a certain colour, the cor-
rection takes more or less effect on this share of colour, respectively brightness of the image. 

The three correction values influence the film image as follows: 

1. Black 

Changes the black level and thus brightness in all image regions. 

 

Figure 23: Black Level Function 

A positive black level raises the brightness over the complete image – it becomes 
whiter. Bright image regions, however, increasingly lose detail by this (they (they 
„clip“ or “burn out”). Conversely, a negative black level makes the image appear 
darker. By this, however, dark image regions lose their structure. 

2. Gamma 
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Change of the medium and dark image regions without significant impact on the 
bright ones and without changes of the black point or the white point. 

 

Figure 24: Gamma Function 

By increasing the Gamma value, the dark image regions are brightened. This can 
make structures emerge, which are there but might not be really visible. A decrease 
of the Gamma value leads to a blackening of dark image regions. This becomes nec-
essary if the image is too bright altogether (e.g. in case of overexposed films) and 
shall appear stronger. 

3. Light 

 

Figure 25: Light Function 

Changing the light value directly influences the intensity of light of the lighting unit 
and makes the image appear brighter or darker in the whole. In contrast to the black 
level, however, a higher gain value does not cause an increase of the black image el-
ements – the image does not appear “whitish”.  Too high Gain, on the other hand, 
leads to a visible loss of structure in the bright regions (they “clip” or “burn out”). 
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In the right area a histogram can be found ("Auto light"), which shows the division of the 
luminosities for the channels red, green and blue. 

By a right click on this diagram, you can change this form of presentation: 

 

Figure 26: Set Histogram 

For most of the applications, the form “Cascade” (separate presentation of the colour chan-
nels) is the optimum. 

The auto light control offers three modes, which you can activate by clicking on the corre-
sponding button on the right: 

1. Brightness 

In this mode, you can have the brightness of all colour channels automatically opti-
mised by the appliance. 

This function is helpful in case of frequent fluctuations in brightness in the film, of 
which the manual correction would be too laborious. 

The white limiting line visible in the histogram marks the maximum brightness allowed 
which must not be exceeded during the automatic optimization. It can be shifted by the 
mouse. 

If this mode is active, settings of the light value cannot be carried out (see Figure 22 
[p.36]). 

2. Colour 

By this mode, the colour values of the motion pictures are automatically optimised. Do-
ing this, an average area of each image is analysed internally and adjusted in terms of 
colour so that the overall impression is neutral to a large extent without changing the 
basic character. 

In the histogram you can find a limiting line for each colour channel which determines 
the maximum value of each colour value which must not be exceeded during the au-
tomatic optimization. These lines can be shifted by the mouse and thus determine a 
basic character as regards colour. 

If this mode is active, settings of the light value cannot be carried out (see Figure 22 
[p.36]). 

3. Off 

When the auto light control is switched off it is possible to influence any colour channel 
manually. All settings made here remain constant during the scanning process. This cor-
responds to a so-called "one light scanning". 
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Figure 27: Manual Correction in the Histogram (Auto light) 

Place the mouse into the diagram of the colour channel to be changed and then keep 
the mouse key pressed and draw to the left to reduce the light (Gain) of the colour 
channel, or to the right to enhance it. The movement of the mouse is shown by a bright 
area (visible in the figure for the green channel).  
Changes made in this histogram correspond to the settings which are possible by the 
function "light" [p. 37]. 

Note: 

If the changes made by you should not lead to a desirable result, it might help to have 
an automatic optimization carried out by thŜ ǇǊƻƎǊŀƳ ƻǾŜǊ ǘƘŜ ŦǳƴŎǘƛƻƴǎ ά.ǊƛƎƘǘƴŜǎǎέ 
ƻǊ άŎƻƭƻǳǊέ ŦƛǊǎǘΣ ŀƴŘ ǘƘŜƴ ǊŜǘǳǊƴ ǘƻ ǘƘŜ άhŦŦέ ƳƻŘŜ ƛƴ ƻǊŘŜǊ ǘƻ ŎŀǊǊȅ ƻǳǘ ŦǳǊǘƘŜǊ ŎƻǊǊŜc-
tions that might be necessary. 

 

Additionally, the “Headroom“ control is available for the automated modes “Brightness“ and 
“colour". This determines the tolerance by which the colour or brightness values are handled 
at the limiting lines set by you.  

If "Headroom" is shifted to the very bottom, the tolerance is defined as 0% so that not pixel 
value surpasses the limitation line. In case of a limit stop of the control at the top, 10% of the 
pixel values surpass the limitation line. Thus, the image appears a little brighter or more col-
ourful and at the same time reacts less sensitively to highlights. 

6.2.3.2 Secondary colour Correction  

 

Figure 28: Secondary Colour Correction 

Unlike the primary colour correction which equally affects the whole image, the secondary 
colour correction impacts single colours in the image. Shade and saturation of each colour 
range can be changed without influencing the rest of the image. 

Thus, you can change e.g. the saturation of the red shades in the image without changing the 
rest of the image content. 

Two controls are available for each of the colour values red, green and blue, respectively 
cyan, magenta and yellow, changing the colour value (“Hue”) and its saturation (“Satura-
tion”). 
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By the "Master" control the overall saturation is being regulated. 

6.2.4 Carry out Further Image Settings  (Advanced Image Settings) 

In the lower part of the screen ("Advanced Image Settings”) you can find options to influence 
the image content. 

 

Figure 29: Advanced Image Settings 

1. Detail 

Enhances the transitions between brightness values.  
This causes a reinforcement of the presentation of details and a subjectively sharper 
image impression. 
This function, however, is not suited for the correction of totally blurred images!  

2. Detail H/V 

Same function as "Detail", but limitation of the effect to the horizontal or vertical im-
age direction. 

3. Crisp H/V 

Enhancement of the edge steepness at the margins of colour transitions rich in con-
trast - separated into horizontal and vertical effective direction. Thus, the image gains 
a more “grainy” character which can subjectively be perceived as increased sharp-
ness. 

Note: 
Make only very sparing use of "Crisp" and "Detail"! In case of too extreme correc-
tion settings, these functions render the scanned image useless for later processing 
(especially magnifications).The effect of these settings can only be judged correctly 
on a HD monitor. Regarding the image e.g. in the small preview window of a video 
cutting program the tendency is to over-sharpen it.   

4. Whiteclip 

Limitation of the white values of the image.  
The overall effect of bloomings and “burnt out“ areas in the image can be reduced by 
this. The function determines a maximum value for the white point which then can-
not be exceeded anymore. 
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Figure 30: Whiteclip Function 

 This function can cause problems in the interplay with the auto light settings 
(see [p. 38]! 

 

5. Knee 

As in many cases a strict limitation of the white value, as e.g. by the Whiteclip func-
tion, leads to a total loss of detail in bright image regions, a correction of bloomings 
or “burnt out” areas can also be reached by the less aggressive knee function. 

 

Figure 31: Knee Function  

Doing this, a limitation of the white values is carried out, too, however differences in 
luminosity present in the limitation area are not completely deleted. Thus, a mini-
mum of structure in the brighter areas remains. 

6. Video gain 

Unlike the Light function (see Figure 22 [p.36]) which directly influences the light in-
tensity during the scanning process, this option enhances the camera signal. This fact 
can make additional reserves of brightness accessible, but also lead to an increase of 
image noise.  

7. Gamma LUT 

Here you can determine by which transmission function the light values from the film 
image in the camera shall be processed. This can be carried out linearly („LUT off“) or 
with a pre-set Gamma-LUT („LUT on“). 

6.2.5 Setting the Sound 
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In the lower part of the screen, you can find the area “Audio” by which the allocation and 
volume of the magnetic sound to be transmitted can be adjusted. 

 

 

Figure 32: Audio Settings 

In the left area you can determine the transmission volume of the given channels, respective-
ly switch off the sound of one channel completely by clicking on “Mute”. 

In the right area you determine from which source the sound is being transmitted (magnetic 
head, see Figure 1 [p.15]). 

Over the button "EQ and Routing" it is possible to connect one of the AES connections of the 
varioHD (compare Figure 2 [p.16]) with the analogue sound output. 

 

Figure 33: Audio Routing 

Select the AES connection the signal of which shall be played back on the analogue output. 
Additionally you can select one equalizer by the button "EQ". 

 

Figure 34: Audio Equalizer 

7 frequency bands which are freely configurable are at your disposal. 
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"Freq" is the central point of the frequency band in the spectrum (kHz) 

Q is the band width 

Bypass switches off the related frequency filter 

These settings can be stored as a file for later use by "Save" and recalled by "Load". 

6.2.6 The Cue Points List 

6.2.6.1 Corrections by Scene (Cue Points) 

The varioHD enables you to scan different scenes of one film with different settings automat-
ically. 

 

Figure 35: Settings List 

In order to use this option, proceed as follows: 

1. Got to a scene and set all necessary parameters.  
Doing this, you can move freely within this scene to search for suitable images. 

2. Then got to the first image of the scene in question. 

3. Click on “Snapshot“ to save all settings for this position.  
In the settings list an entry appears with a serial number and the description “Set-
tings at NNN” (NNN = number of the starting image of the scene). Doing this, all set-
tings relevant for the image are stored: 

· Primary Colour Correction 

· Secondary Colour Correction 

· Geometry 

· Advanced Image Settings 

You can edit the entries saved this way later (p. 6.2.6.2 Edit Cue Points [p.46]). 

4. However, if you would like to save only particular settings for the current position 
you can proceed as follows: 

a. Drag and drop the names of the desired group of settings (e.g. "Geometry") 
to the empty area of the table to create a new entry at the current position in 
the table. If an entry already exists at the current position, the corresponding 
settings are added to this entry (or respectively overwritten, if any entries 
have already existed for the related group of settings). 

b. Drag and drop the settings to an existing entry of the table to add or change 
the settings there. 

You can edit the entries saved this way later (p. 6.2.6.2 [p.46]Edit Cue Points [p.46]). 

5. Proceed analogously for all further relevant scenes.  
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6. Before starting the scan, run the film completely back to the first image and activate 
the settings list by clicking on „Linked“.  

 

Figure 36: Activated Settings List 

When the film now reaches a position saved in the list during the scanning, all correc-
tion settings related to it will be activated. 

Independently if further changes of scene follow, the correction settings remain in force for 
the following film images until a new position of the settings list or the end of the film is 
reached! 

 

Note: 
You can use the saved cue points in two different ways: 

a) Select image position directly 
To do this, click on the corresponding entry on the right and select  "Go to" in the con-
text menu. Thus, you can also use the settings list as pure positions storage in order to 
change quickly between single positions. Note, however, that frequent winding of the 
film mechanically strains it and increases the danger of dirt or damage! 

b) Select settings of a determined image position 
To do this, double-click on the corresponding list entry. 
Thus, all settings saved for this position are activated und now in the current position 
???? 

All list entries are conserved until 

· the whole list is deleted by a click on "Clear" 

· a single entry is removed by a right click and "Delete" 

· or the operating software is exited 

Therefore, after changing the film, the settings list should be deleted, unless the settings are 
also valid for the next film to be scanned. 

A settings list can be saved by „File -> Save Cue point list…“ and reloaded again later by „File 
-> Load Cue point list…“. The SML files saved this way can be archived for the tasks as you 
wish. 

 

Tips for working with the settings list: 

1. Reuse settings for a film later 
In order to be able to scan the same film once more afterwards with the saved set-
tings, an unambiguous starting image must be determined already with the first 
scanning. To do this, proceed as follows: 
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- Go to a distinctive image at the beginning of the film. 

- Set the frame counter at this position to 0 (p. Figure 17 [p.30]). 

- Save this position by "Snapshot" as point in the settings list and give it an unam-
ōƛƎǳƻǳǎ ƴŀƳŜΣ ƛŦ ŀǇǇƭƛŎŀōƭŜ όǇΦ α6.2.6.2 [p.46] Edit Cue Pointsά [p.46]). 

- After having made all settings for this film and fixed them in the settings list, save 
ǘƘŜ ƭƛǎǘ ōȅ αFile -> Save settings list…άΦ Doing this, use a name which assures the 
relation to the film just edited. 

- When reinserting the same film later, go to the distinctive image mentioned 
above and there set the frame counter to 0 again. 

- Load the settings list belonging to this film. 
Now all previous settings are available frame-accurately. 

2. Determine automatic stop for the scanning 
In order to avoid that the film completely rolls off the source reel after finishing a 
scanning, you should adopt the last image to be scanned into the settings list. 
Then do not start the scanning process by , 
ōǳǘ ōȅ ŀ ǊƛƎƘǘ ŎƭƛŎƪ ƻƴ ǘƘŜ ƭŀǎǘ Ǉƻǎƛǘƛƻƴ ŀƴŘ ǘƘŜƴ αDƻ ǘƻάΦ 
After reaching this image, the film stops and after that can be rewound to the initial 
position, if necessary. Besides all links between film and settings list are conserved. 
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6.2.6.2 Edit Cue Points 

You can edit the cue points afterwards. To do this, select “Edit” in the context menu (right 
click) of the cue points. 

 

Figure 37: Edit Cue-Point 

The Cue Point Editor opens by which you can make the following settings for the selected list 
entry: 

1. Changing the name 
As a standard, the name "Settings at <Pos.> is entered. You can enter a characteristic 
name here. 

2. Shifting the related image position ("frame") 
This makes sense when it has turned out that, when adding the cue point to the set-
tings list, not the correct image position (e.g. the starting image of a scene) was se-
lected. 
In order to move the film to the image position displayed at "frame" at the moment, 
just click on "Cue". If the film is in this position, it is tracked directly while you change 

the image number step by step by  in the editor. 

Note: 
For technical reasons, certain settings of the setting list are only realised with a cer-
tain delay. By this function, a forward displacement of the operation point for such a 
case is possible, so that the effect takes place frame-accurately. 

3. Deleting particular settings groups 
In the field "Contained Settings" you can find a list of all settings groups related to 
this cue point. After selecting one entry, the changes caused by this settings group at 
the current image position, become ineffective by "Delete". 
Note, however, that by this also possible influences by this settings group from previ-
ous image positions become effective at the current position. 

Example: For image 456 geometry and framing settings exist. After deleting the set-
tings group "geometry" for this image, the geometry settings made at im-
age 123 now remain effective until new parameters are saved for a later 
position (here 789). The framing options remain untouched by this. 

Cue-Point Geometry Framing 

 
Geometry Framing 
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123     

 

    

456 
    

 

    

789     

 
    

6.3 Further Functions of the Operating Software 

6.3.1 Illumination of the Working Area 

The illumination of the working area (skid plate) can be controlled by clicking on the figure of 
the camera optics in the "Prepare" section. 

 

Figure 38: Control illumination working area 

The shift control becoming visible then enables you to adjust the luminosity. 

By clicking on a free area of the operating software, you will exit this function. 

6.3.2 Store and Load Settings 

The operating software offers different possibilities to save current settings temporarily or 
permanently and recall them. 

6.3.2.1 Short-term Storage 

In order to save and recall settings only for the current session, the function keys F1 to F8 are 
available. 

Press one of these keys for longer than 2 seconds to save the current settings. Then the relat-
ed button at the top frame of the program window becomes coloured. This signalises that 
the settings can be saved and recalled by (shortly) pressing the functional key again.  

 

Figure 39: Function Key 

As an alternative you can click on one of the buttons for longer than 2 seconds to save, and 
click on the related button shortly to load.  

When the flashsuite is exited, all settings saved this way will be lost. 

( 
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6.3.2.2 Long-term Storage 

For a permanent storage of settings, the flashsuite offers two possibilities: 

a) Menu "File -> Save session settings..." 
By this, all current settings in one file are saved, which you can recall by "File -> Load 
session settings..." anytime. 

b) The symbol . 

This is available in selected sections and enables the storage and recovery of settings 
only in this section. 
In sections which do not contain the symbol, the values set there cannot be saved. 

A click on this symbol opens the following submenu: 

 

Figure 40: Settings load/ save 

When choosing one of the listed settings, the values linked to it are adopted for the 
related section. 

By "Edit" you can file the current settings or delete existing states. 

In order to save the current settings as new default enter a name at the left side of 
the window opening after that and then click on the button . This saves the set-

tings in the list "Existing pre-sets". 

"Description" is an area where a description is available by factory settings. It cannot 
be changed. 

In order to delete pre-settings already existing, mark the name concerned in the list 
and then click on "Delete". 

 

Figure 41: Settings save/ delete 

Note: 
In certain situations, names in the form "[xxx]" are already available in the list belong-
ing to the "name" field. Saving your settings under one of these names, you define 
them as default for a certain operation mode. These settings are adopted automati-
cally as soon as the related mode has been switched on. 

Examples: 
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Name Settings become effective automatically, when... see 

[Negative] the option "Negative" is active Figure 21 [p.34] 

[Positive] the option "Negative" is not active Figure 21 [p.34] 

[16mm] "16mm" is set as film format Figure 9 [p.25] 

[35mm] "35mm" is set as film format Figure 9 [p.25] 

6.3.3 Metadata 

The varioHD offers the possibility to record and save numerous values measured during a 
scanning process. This allows a precise analysis of the present film material. 

Any measured value is assigned to one position on the film (frame). 
Therefore, it is important for the subsequent evaluation to define an unambiguous starting 
position before beginning the scanning [S. Fehler! Textmarke nicht definiert.]! 

Over the menu item "View -> Metadata" you can display, configure and save this infor-
mation. 

 

Figure 42: Metadata 

In the top of the window you have the possibility to enter general information to the current 
measurements. As a standard, the fields "Name" (e.g. project name) and "Operator" (e.g. 
name of the editor) are at your disposal. This information, in case of saving the metadata, is 
stored in the corresponding file and enables a more precise assignment of the measured val-
ue to films, operators, processes etc. 

You can configure these fields freely. 
To do this, close the flashsuite and open the text file "metadatafields.txt" which can be found 
in the programme directory of the flashsuite (usually " „<Programs>\flashsuite“). 
There enter the name of the desired fields and its length (number of characters) line by line. 

Example: 
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Project=100  

Operator=100  

Film=100  

Roller=4  

After that the following fields will appear in the heading of the metadata window af-
ter the next start of the flashsuite: 

 

Figure 43: Metadata Information Fields 

The field "Roller" is limited to 4 characters, all other fields to 100 characters. 

By the option "Capture metadata" you switch on, respectively off the recording of values. 

The recording is first only made in the main memory! Shall the values be saved permanently, 
the button "Record“ must be pressed additionally. If no file is being indicated yet to save the 
data in, a dialogue will open where this must be defined. The menu command „File -> Choose 
recording file…“  enables to change name and folder of this file. The recording is carried out 
in the XML format and can be evaluated with suitable software afterwards. 

You can export information recorded in the main memory to a XML file afterwards as well. To 
do this, use the menu "File -> Save as XML…"  

The menu command "Clear" deletes all previous recordings. 

The varioHD registers the following information: 

Group Information Explication see page 

Settings Speed Scanning speed 29 

 Zoom Zoom position 31 

 Lightmode State of the auto-light mode 38 

 Focus Focus settings 31 

Command data Crisp Settings for "Crisp" 40 

 Knee Settings for "Knee" 41 

 DetailH Settings for "Detail H" 40 

 MainGamma Settings for "Gamma" 36 

 AutoTargetLevelBlue Auto-light target level for blue 38 

 MasterBlack Settings for "Black level" 36 

 Detail Settings for "Detail H" 40 

 AutoTargetLevelRed Auto-light target level for red 38 

 Gain Settings for "Gain" 41 

 WhiteClip Settings for "WhiteClip" 40 

 AutoTargetLevelGreen Auto-light target level for green 38 

 DetailV Settings for "Detail V" 40 

Analysing RedLight Red share of the scanning light --- 

 GreenLight Green share of the scanning light --- 

 Pitch Changing of length of the film --- 
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Group Information Explication see page 

(negative values = shrinkage) 

 BlueLight Blue share of the scanning light --- 
    

When you click on a position of the recorded blue line, the film will be positioned to the re-
lated film image. 

Red triangles  within the graphic mark frames where a defective perforation has been spot-
ted. 

 

Figure 44: Graphic Metadata 

A detailed list of the perforation wholes recognized as defective can be shown by a click on 
"Bad Perforation". 

 

Figure 45: List „Bad Perforation“ 

You can go to the film positions in question by a double click on one entry. 

Note: 
It is not possible to export recorded graphics. 
For a detailed evaluation, please use the option for the recording oŦ ·a[ ŦƛƭŜǎ όǎŜŜ αά ǇΦ 50). 
Equally, recorded data cannot be loaded for display afterwards. 

Attention!  
When you change into the "Load" state [p. 25] all metadata will be lost! 

6.3.4 Menu Structure 
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In addition to the mentioned functions, the operating software offers the following further 
options available over the menu: 
 

Menu Option Explanations 

File Load session settings… Load a settings list (see section 6.2.6 [p.43]) 

 Save session settings… Saving the settings list (see section 6.2.6 [p.43]) 

 Load Cue point list… Load a cue point list (see section 6.2.6.1 [p.43]) 

 Save Cue point list… Saving the current cue-point list (see section 6.2.6.1 [p.43]) 

 Connect Reconnection to the varioHD 

Options Bars Generate SMPTE colour bar for the screen calibration. 
this function will be reactivated by renewed selection. 

 HID Mapping Assignment of joystick keys to program functions 

 

Figure 46: HID Mapping 

If you use a joystick to control the varioHD you can assign a key or operating 
function of the connected joystick to the program functions listed in the 
column “Controls”. 

This can be carried out by selecting a joystick function from each available 
list (column “Joystick”) or by clicking on the button “Find” and pressing a 
joystick key afterwards. 

Clear Delete all settings carried out 

Cancel Close this option without changes  

Apply Adoption of all previous changes  

Apply and close Adoption of all previous changes and close this 
option  

 Preferences Connection 
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Menu Option Explanations 

 

Figure 47: Options "Connection" 

For Mac systems or if the USB connection was not successful, an explicit 
allocation of ports may be necessary. To do this, assign the corresponding 
USB connection for the controller and the camera. Should you use an MWA-
flashcommander, it can be allocated as well. 

Interlacing Settings 

 

Figure 48: Options "Interlacing settings" 

By "Field dominance“ the field dominance for interlaced video is defined 

(see also Special Features in Case of Interlaced Format“ page 35). The 
settings made here must be in accordance with the ones of 
the later reproducing system or the processing software. If 
you are not sure which setting is correct, simply test both 
settings by a short scene with rapid horizontal movements. 
Edit and compress the material as intended and reproduce it 
on an interlaced monitor. Then you are usually able to recog-
nize which is the correct setting. 
For most applications "Upper field" applies. 

„Pulldown method“ decides on the post-processing of the fields, in case 
you are scanning at a speed of less than 25 frames per second. In this case, 
intermediate images must be inserted. Two methods are available to do 
this: 

Frame insertion: Complete images (frames) are inserted always 
(the previous image is repeated). This method is suitable if the 
scanning speed has an integral division ratio to 25 fps (e.g. 
12,5 fps) 

Field insertion: This method should be chosen if the scanning 
speed does not present an integral division ratio to 25 fps.  In a 
case like this the controller would in fact have to repeat a lot of 
frames in order to balance the lacking integrity. In "Field inser-
tion", in contrast, it mixes the fields the way that the result is a 
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Menu Option Explanations 

regular overall impression. 

 

Figure 49: Frame and field insertion 

 Event Messaging 

 

Figure 50: Options "Event Messaging" 

By this option you can control the behaviour?? of the varioHD for the fol-
lowing operating situations: 

 

Spool is running free The film is not inserted or torn, resp. the 
end of the film has been reached 

Runmode left Run mode has been left (see p.  24] 

Runmode reached Run mode has been reached (see p. 24] 

Synchronization lost No synchronization with the appliance 

Synchronization reached Synchronization with the appliance estab-
lished 

Particular reactions can be assigned to these situations, which are added to 
the “Actions” list (centre) by clicking the button “<”, , respectively removed 
from it by ">": 

Beep 1, Beep 2 Output sound signal 1 or 2  

Decklight on/off Lighting of control panel on or off 

Tally blink/off Signal lamp blinks or is off 
   

View Fullscreen Switch on or off full screen presentation of the operating software 

 Metadata see Fehler! Verweisquelle konnte nicht gefunden werden. „Fehler! Ver-
weisquelle konnte nicht gefunden werden.“ [p.Fehler! Textmarke nicht 
definiert.] 

 Focus LUT see Additional Function „Focus LUT [p.32] 

   

Help About Display of general information on the operating software (particularly the 
version number) and input of the license key. 

 
By “Send“ each input license key is transmitted to the varioHD. 

 Show tooltips Switching on/off the displayed help information when the mouse is posi-
tioned above certain elements of the operating surface. 

6.3.5 Keyboard Shortcuts 
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Some functions of the operating software can be controlled directly over the keyboard. The 
corresponding keyboard shortcuts are listed below. 

Moreover, settings in which shifts of controls or lines are necessary, can be made much more 
precisely by using the cursor keys than the mouse. For this purpose, the element concerned 
must first be selected (activated) by a mouse click.  After that, a  shift in very fine single steps 
can be made over the cursor keys (compare e.g. the instructions for the determination of the 
output format on page 31 and page35). 
Additionally, a change between single active elements of the screen is also possible by the 
tabulator key (TAB resp. Shift-TAB). 

 

Function Keyboard Shortcuts 

Play / Stop Space bar 

Framing (positioning of a frame line)  ↑. and  ↓. 

Frame forwards/ backwards  ←  and  →  or  J  and  L.  

Settings list: Snapshot at the current position  S.  

 Select settings 0 to 9  0 … 9  on the numeric pad 

 Go to cue points 0 to 9  Strg +  0 … 9  on the numeric pad 

Increase and decrease the transport speed  + and  –  on the numeric pad 
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7 Debugging 

The errors described below are only related to faults in the operation process which are due 
to particular unsuitable starting conditions and can therefore be easily remedied by the user 
himself. 

 

Do not open the appliance! Otherwise, unpredictable states and damages to components 
might occur and the warranty can be lost! 

 

Before enlisting the services of MWA, you should try to diagnose and remove the origin of 
the fault yourself on the basis of the given remedies. This does not only save time but possi-
bly also expenditure which might occur when special staff is ordered. 

If a fault cannot be remedied by the steps described below, please contact our service ad-
dress (p. 10). 

 

The electrical fusing of the varioHD is granted by micro fuses which are arranged within the 
appliance. Access to these components, however, is reserved exclusively for the MWA ser-
vice.  

 

Do not open the appliance and do not replace any of the existing micro fuses!  

 

Otherwise, unforeseen states and damages of components may occur and the warranty 
might be lost! 

The following table describes those faults which the user can normally diagnose and remove 
himself. Some malfunctions or failures might also be due to electrical problems, especially to 
blowing internal fuses. If a correction is not possible on the basis of the information given or 
if you are not sure about possible causes and effects, please contact MWA immediately (see 
Service Address [p.10]). 
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Fault  Cause  Remedy 

varioHD cannot be controlled  No contact to the appliance (operating 
software has been started BEFORE 
switching on the appliance or appliance 
has not been switched on) 

Check if the varioHD is switched on and con-
nected to the PC over the USB connection. 
Re-establish the connection over the menu “File 
-> Connect“. 

Message „Could not connect to 
varioHD / varioHD B is not valid“ 

No contact to the appliance (operating 
software has been started BEFORE 
switching on the appliance or appliance 
has not been switched on) 

Check if the varioHD is switched on and con-
nected to the PC over the USB connection. 
Re-establish the connection over the menu “File 
-> Connect“. 

Red signal lamp is lit Depending on the allocation of this 
signal in the menu “Options -> Event-
Messaging“ (see p. 54) one of the fol-
lowing states has occurred: 

¶ The film has not been inserted, is 
torn or the end of the film has been 
reached  

¶ The Run mode has been reached or 
finished 

¶ The synchronization of the operat-
ing software with the varioHD has 
been established or interrupted  

If applicable, react to the state occurred accord-
ingly  

Operating software displays an 
exclamation mark over one of 
the two film reels 
 

The film has run out of track at the 
marked position, as the end of the film 
has been reached or the film is torn 

Re-insert the film, click on the symbol of the 
signal lamp on the screen to reset it and then 
change into the Run mode (p. 24) 

Film is not being tightened - Wrong winding direction set in the 
operating software 

Check if the actual winding direction on the 
appliance corresponds to the graphic on the 
screen. Proceed as described in section 6.1.1.5 
„Establish Run Mode“ [p.24]. 

 - Wrong film type set Check the settings as to the film type in the 
operating software [p. 25] 

Film path vibrates (Run mode) Film inserted incorrectly (the varioHD 
cannot establish the correct film ten-
sion) 

Check the correct film path. Proceed as in sec-
tion 6.1.1.2 „Set Film Path“ [p.22]. 

Film path vibrates (Wind mode) Film inserted incorrectly (the varioHD 
cannot establish the correct film ten-
sion) 

Check the correct film path. Proceed as in sec-
tion 6.1.3 „Winding the Film “ [p.27]. 

Film is not detected. 
Message: “Perforation not 
detected / Please check film 
format settings and proper 
lacing of film“ 

- Wrong film format set Set the right film format in the operating soft-
ware. Proceed as in section 6.1.1.3 „Set the Film 
Format “ [p.23]. 

 - Perforation sensor set incorrectly Check if the perforation sensor is set correctly 
corresponding to the film format and has en-
gaged at the corresponding position. Proceed as 
in section 6.1.1.3 „Set the Film Format “ [p.23]. 

varioHD does not change into 
the Run mode 

- No contact to the appliance Check if the varioHD is switched on and con-
nected to the PC over the USB connection. 
Restart the operating software 

 - Film not or not correctly inserted, 
resp. winding direction wrong  

Check the correct film path. Proceed as in sec-
tion 6.1.1.2 „Set Film Path“ [p.22]. 
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Fault  Cause  Remedy 

No sound - Magnetic head not activated Check if the magnetic head has been pulled 
forwards and has engaged. Check the correct 
position of the film at the guiding rollers  of the 
magnetic head. Proceed as in section 6.1.1.4 
„Activate Sound“ [p.23]. 

 - Film has no sound track or sound 
track contains no information  

--- 

 - Audio track switched to mute Check if the mute switch under "Audio" in the 
settings is activated  [p. 41]  

Sound muffled - Magnetic head dirty Clean the magnetic head [p. Fehler! Textmarke 
nicht definiert.] 

 - Magnetic head has no sufficient con-
tact to the sound track  

Check if the sound track of the film is in tight 
contact with the magnetic head while running 

no picture or picture too dark - Disturbance of cable or monitor Check the (HD)SDI connection to the varioHD as 
well as the monitor itself 

 - Incorrect colour correction settings The colour correction values might be set the 
way that the image is too strongly darkened.  
If applicable, reset all values in the operating 
software by clicking on all “0“ buttons (see 
Figure 15 [p.29]) 
Start working with the auto-light function [p. 
38]. 

 - Lighting unit defective or not in the 
right position 

Check if the lighting is working and the lamp 
housing is positioned as far as possible upwards 
in the direction of the filmgate 

 - Objective lid has not been removed Remove the protection lid of the objective 

Picture too bright - Incorrect colour correction settings The colour correction values might be set the 
way that the image is too strongly darkened.  
If applicable, reset all values in the operating 
software by clicking on all “0“ buttons (see 
Figure 15 [p.29])  
Start working with the auto-light function [p. 
38]. 

 - Surrounding light too bright Close covering hood 
(see Figure 1 [S. 15]) 
Turn off bright ambient light or additionally 
darken the room 

Image distorted - Anamorphic mode switched on alt-
hough the image itself has not been 
recorded anamorphically 
 

Switch off the “Anamorph“ mode (see Figure 21 
[p.34])  

 - Video format SD 16:9 selected, but 
monitor set to 4:3 or vice versa 

Choose a suitable video format (see Figure 21 
[p.34]) 

Image is upside down Film was not rolled to the beginning Remove the film and roll it back to the beginning 

Image is inverted "Mirror" is activated or the film was/ 
could not be inserted true to side 

Switch on, resp. off, the function "Mirror" [p. 35] 

Image cannot be focused Bad image quality on the film To focus, shift the film image by the "Pan" func-
tion [p. 31] so far that parts of the perforation 
become visible and focus them. 
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Fault  Cause  Remedy 

Fault in the image - Optics or illumination dirty 
(noticeable in "blurred" image faults) 

Clean the optics and the lighting unit as de-
scribed from page 61 on 

 - Cable defect Check all transmission cables of the varioHD up 

to the monitor, resp. recorder and replace them 
(for testing purposes). 
In case of doubt contact MWA. 

 - Camera unit defective Contact MWA 

 - Interlaced mode with wrong field 
settings 

Change the settings to handle fields in the inter-
laced mode [p. 53] 

 - Pixel fault on the monitor Compare a scanned image with the presentation 
on the monitor. Is the fault not visible in the 
scanned image, the monitor is defective 

 - Film dirty Clean the film 

bad picture steadiness  - Film is running backwards The film may only run forwards (from the left to 
the right) in the scan mode 

 - Perforation defective Try to work with higher tolerance for the detec-
tion of the perforation [p. 27] 

 - Wrong scanning speed Only set speeds for the scanning which are not 
marked by an asterisk (*) [p. 30] 

Image is "pumping" (rhythmic 
changes in luminosity) 

Alignment of the optics was misadjusted 
(correction of luminosity overcharged) 

Check if the diaphragm is on 5,6. 
In case of doubt, contact MWA 

Image does not react to geome-
try and colour settings 

Output monitor/ recorder connected 
with wrong (HD)SDI output 

Connect the monitor with the (HD)SDI output 1 
or 2 

Images are double-scanned  Scanning speed is lower than 25fps Read the notes to Special Features in Case of 
Interlaced Format on page 35 

Measured values (Metadata) 
are not recorded 

- Recording deactivated Activate the option "Capture Metadata" 
[p. Fehler! Textmarke nicht definiert.] 

 - No recording file indicated Determine a file in which the measured values 
shall be recorded. Save possibly existing data 
subsequently [p. 50] 

frame counter is not correct 
anymore 

Appliance has been reset in the mean-
time (load-stop switch or emergency 
stop after transport fault) 

Run the film to the beginning and re-register the 
starting image [S. 30] 
Only operate the load-stop switch if the film 
shall be removed 

Film is being scratched - Dirt in the film track! Control all rollers (especially the guiding rollers 
of the possibly active magnetic head  and clean 
them if necessary 

 - Film is running over an edge! Check if the film is running impeccably through 
all guidings 

Film is tearing Too much tension Decrease tension [p. 26] 
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8 Service and Maintenance 

The varioHD is designed to work without maintenance to a great extent. In order to grant an 
impeccable function, only the following regular jobs have to be carried out: 

- Remove dirt and residues on the rollers in the film path (at least once a week). To 
do this, compressed air or a fuzz-free rag can be used. A more intensive cleaning 
of the film path is only necessary if residues have developed on the rollers which 
cannot be removed like this. Use exclusively isopropanol and a fuzz-free rag for 
this. On no account, cotton swabs or paper tissues should be used! 

- PTR film cleaning rollers 
If you use these, they should ideally be cleaned before each scanning, at the lat-
est, however, when clearly visible traces of dirt occur. Dirty surfaces on these 
rollers cannot absorb dust from the film. In the worst case particles are even 
passed back to the film.  

Attention!  
Only clean these reels by hand in lukewarm water! 
Never use dissolvent or detergents, brushes or cloth! 
This would damage the coating, render the adhesion inoperative and cause the 
danger of mechanical damages on the film surface by developing roughness. 

Do not clean the rollers in the air without using a rag. 

Note: 
The PTR rollers can be shifted forward on the axes, or respectively mounted after 
rotating through 180°. Thus, it is possible to have further films run over not yet 
used areas of the cleaning rollers and save cleaning effort. 
Make sure, however, when shifting the rollers, that the film always has enough 
running surface and is not running off the roller. 

- Capstan 
The deflection roller at the capstan should be cleaned regularly, ideally before 
each scanning. Otherwise dirt residues may lead to a reduced static friction be-
tween roller and film, by which synchronisation and frame counting become 
faulty. Use only damp, fuzz-free rags for this. In exceptional cases, Isopropanol 
can be used, too. 

- Optical sound head 
Check before and during each scanning if the guiding rollers (Figure 7 [p.24]) are 
free from dust and other dirt. For technical reasons, it is necessary that the guid-
ing rollers of the magnetic head rest on the film. Thus minimal impurities might 
damage the film. Especially hairs and the like, wrapping around the rollers, can 
lead to lengthwise scratches or exposures by pressure. 
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- Magnetic sound head 
Here the things said about cleaning the optical sound head are valid analogously. 
Additionally, note that the film is laced over the magnetic head in direct contact. 
Thus, residues quickly develop here, which become visible as smearings in ex-
treme cases.  
 
Therefore, if applicable, clean the sound head with isopropanol using a fuzz-free 
rag. 

- Optics 
The external lens of the camera should be checked for dust residues on a regular 
basis. These might cause reproduction faults or be themselves visible in the im-
age. To clean,  set the zoom to a maximum [S. 31], so that the camera runs to the 
very bottom. Afterwards loosen the locking screw on the right side of the camera 
cover and shift it to the very top (see Figure 1 [p.15]). 
Now you can clean the surface with an optical brush, a soft fuzz-free rag or 
cleaned technical compressed air. 

Breathing air or ambient air is unsuitable for this, as contained impurity and 
humidity deposit on the optical components! 

Never use solvent! This leads to an irreversible damage of the surface refine-
ment. Intractable impurities can be removed with a damped, soft and fuzz-free 
rag. 

- Lighting source 
Hold on to the lamp housing, loosen the locking screw on the left side and shift 
the case down to the bottom limit stop. After that you can free the glass surface 
from dust and residues by using cleaned technical compressed air, or alternative-
ly a cleaning rag for optical devices! Persistent impurities can also be removed 
with Isopropanol. Afterwards run the lamp housing up to the top limit stop and 
lock it. 

- Fan at the filmgate 
Only clean the fan when the filmgate is demounted [p. 21]. 
Use exclusively cleaned technical compressed air. 

- Photo diode at the perforation sensor [p. 23]. 
Cleaning is only necessary, if faults keep occurring at the registration of perfora-
tion wholes. Use exclusively fuzz-free rags or cleaned, technical compressed air 
for the cleaning! 
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Attention!  
Never carry out the cleaning while the appliance is operating! 
This might cause mechanical or electrical damages of the appliance, as well as considerable 
injuries. 

Further jobs are not necessary within the framework of care and maintenance, respectively 
can only be carried out by MWA. 

Please note especially the following: 

- Do not oil any rollers or bearings! 

- Do not open the appliance! 

- Do not loosen or fix screws or other fixtures on the appliance and in the film 
path! 

In case of doubt, please contact the service address (page 10). 



63 

Subject Index 

 

(HD)SDI  5, 13, 15, 16, 18 

1080i50  32 

16:9  32 

16mm  47 

35mm  47 

4:3  32 

720p50  32 

Advanced Image Settings  27 

AES/EBU  13, 15, 16, 18 

Analogue  15 

Analogue IN  15, 18 

Analogue OUT  15, 18 

Audio  15, 18, 27 

Auto Light 

Off  36 

Automatic pre-settings  23 

AutoTargetLevelBlue  48 

AutoTargetLevelGreen  48 

AutoTargetLevelRed  48 

Biphase  16 

Black  34 

Black and White  32 

BlueLight  49 

Brightness  36 

Button 0  19 

Capstan  14, 58 

Cascade  36 

Color  36 

Color Correction  27 

Commanddata  48 

Connection  50 

Crisp  48 

Crisp H/V  38 

Cue point list  27, 50, 53 

Detail  38, 48 

Detail H/V  38 

DetailH  48 

DetailV  48 

Field dominance  50 

Field insertion  50 

File  50 

File  42, 48 

Choose recording file…  48 

Load Cue point list…  42 

Save as XML…  48 

Save Cue point list…  42 

File 

Load session settings…  50 

File 

Save session settings…  50 

File 

Load Cue point list…  50 

File 

Save Cue point list…  50 

File 

Connect  50 

Filmgate  14, 19 

Film cleaning roller  see PTR 

flashsuite  47 

Focus  48 

Focus LUT  30 

Frame insertion  50 

Gain  48 

Gamma  34 

Gamma LUT  39 

Genlock  15, 16 

Geometry  27 

GPIO  15, 16, 18 

GreenLight  48 

HD  5, 13, 15, 16 

Headroom  37 

Help  52 

Help 

About  52 

Help 

Show tooltips  52 



64 

Interlacing Settings  50 

Knee  39, 48 

Laser  14 

Light source  14 

Light  35 

Lightmode  48 

Load  24, 25 

Load-Stop-Schalter  14, 22, 23, 25 

LUT  5, 30, 39 

LUT off  39 

LUT on  39 

MainGamma  48 

MasterBlack  48 

Negative  47 

Power connection  11 

Power switch  15 

Optics  14, 59 

Options  50 

Options 

Bars  50 

Options 

HID-Mapping  50 

Options 

Preferences  50 

Options 

Event.Messaging  52 

Output Processing  27 

Perforation Detection  24 

Perforation sensor  14, 21 

Pitch  48 

Positive  47 

Primary Color Correction  34 

PTR  5, 14 

Pulldown method  50 

Record  48 

RedLight  48 

RGB  5 

RS 422  15 

RS422  18 

Run  23, 24 

Protection class  11 

SD  5, 13, 15, 16 

Secondary Color Correction  34, 37 

Signal lamp  14 

Speed  48 

Symbol Diskette  46 

Tension  24 

Magnetic head  14, 58, 59 

Transport  27 

USB  5, 15, 16, 17, 18 

Videogain  39 

View  52 

Focus LUT  52 

Fullscreen  52 

Metadata  52 

Whiteclip  38 

WhiteClip  48 

Wind  25, 26 

YUV  5 

Zoom  48 

 



65 

Table of Figures 

Figure 1: Front View .................................................................................................................. 15 

Figure 2: Back View ................................................................................................................... 16 

Figure 3: System Integration ..................................................................................................... 17 

Figure 4: Disassamby of the filmgate ........................................................................................ 22 

Figure 5: Settings of the perforation sensor ............................................................................ 23 

Figure 6: Activation magnetic head ........................................................................................... 24 

Figure 7: Guiding rollers at the magnetic head ......................................................................... 24 

Figure 8: Example film path ...................................................................................................... 24 

Figure 9: Selection of film format ............................................................................................ 25 

Figure 10: Operating order ........................................................................................................ 26 

Figure 11: Tension ..................................................................................................................... 26 

Figure 12: Perforation Detection............................................................................................... 27 

Figure 13: Film Path for Rewinding ........................................................................................... 28 

Figure 14: Wind Control ............................................................................................................ 28 

Figure 15: Start Screen Run Mode ............................................................................................ 29 

Figure 16: Film Speed ................................................................................................................ 30 

Figure 17: Go to Image Position ................................................................................................ 30 

Figure 18: Setting the Image Geometry .................................................................................... 31 

Figure 19: Focus LUT ................................................................................................................. 32 

Figure 20: Focus LUT correction ................................................................................................ 33 

Figure 21: Output Processing .................................................................................................... 34 

Figure 22: Primary Colour Correction ....................................................................................... 36 

Figure 23: Black Level Function ................................................................................................. 36 

Figure 24: Gamma Function ...................................................................................................... 37 

Figure 25: Light Function ........................................................................................................... 37 

Figure 26: Set Histogram ........................................................................................................... 38 

Figure 27: Manual Correction in the Histogram (Auto light) .................................................... 39 

Figure 28: Secondary colour Correction .................................................................................... 39 

Figure 29: Advanced Image Settings ......................................................................................... 40 

Figure 30: Whiteclip Function ................................................................................................... 41 

Figure 31: Knee Function ........................................................................................................... 41 

Figure 32: Audio Settings .......................................................................................................... 42 

Figure 33: Audio Routing ........................................................................................................... 42 

Figure 34: Audio Equalizer ......................................................................................................... 42 

flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc


66 

Figure 35: Settings List .............................................................................................................. 43 

Figure 36: Activated Settings List .............................................................................................. 44 

Figure 37: Edit Cue-Point ........................................................................................................... 46 

Figure 38: Control illumination working area ........................................................................... 47 

Figure 39: Function Key ............................................................................................................. 47 

Figure 40: Settings load/ save ................................................................................................... 48 

Figure 41: Settings save/ delete ................................................................................................ 48 

Figure 42: Metadata .................................................................................................................. 49 

Figure 43: Metadata Information Fields ................................................................................... 50 

Figure 44: Graphic Metadata .................................................................................................... 51 

Figure 45: List „Bad Perforation“ .............................................................................................. 51 

Figure 46: HID Mapping ............................................................................................................. 52 

Figure 47: Options "Connection" .............................................................................................. 53 

Figure 48: Options "Interlacing settings" .................................................................................. 53 

Figure 49: Frame and field insertion ......................................................................................... 54 

Figure 50: Options "Event Messaging" ...................................................................................... 54 

 

flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc
flashtransfer_vario_manual.doc

